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1. XTM Connect - AEM Introduction

This manual describes how to install, configure and use the modules required for Adobe Experience
Manager to integrate with XTM.

General information

e AEM has a synchronous line per line translation mode, this is generally referred to as Translation
API 1.0 and is always an MT type of translation.

¢ AEM has asynchronous per document translation referred to as Translation API 2.0 and can be
either human- or machine-translation.

2. XTM Connect - AEM Prerequisites

Prerequisites

e Access to an AEM 6.3 installation
e Acces to an XTM server

3. Installing the XTM Connect - AEM

To install the XTM Connect for AEM as a translation provider, the CrossLang-XTM connector package
must be downloaded from Package Share. After installing the package, you can create a cloud
configuration as is described in Configuring the AEM-XTM Connector below.

Working with Packages

For more information on how to work with packages, please refer to
http://docs.adobe.com/docs/en/aem/6-3/administer/content/package-manager.html.

Summary of steps:

e Obtain the CrossLang-XTM connector package
e Upload the package

e Install the package

Obtaining the CrossLang-XTM Package from Adobe Package Share

To obtain the CrossLang-XTM package, proceed as follows:
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1. Open a browser and navigate to https://www.adobeaemcloud.com/content/packageshare.htmil:

4 Back 1o Packages upioag

Keywords ADOSE SHARED PRIVATE

‘Shomeg festured Adcbe packager

Elastic Path Commerce for
Marketing Cloud

4 Back 10 Packages uploas

ADOBE SHARED PRIVATE

Social Communities

Afuly ntograte
expodences as
Semand

Crosstang-XTM- Translation

>

International

International
¥ ¥
& 9 & 9 & v

Crossang- K- Translation.

Intornational

¥

& e

3. Click on the CrossLang-XTM-Translation-Connector tile to see the package's details and
download the package using the download link provided on the Assets tab:
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instan

Notes:

o AEM 6.3 requires version 1.3.x of the XTM connect.

o The connector package can also be downloaded directly from within AEM by accessing
Package Share via the CRX Package Manager
(http://localhost/crx/packageshare/index.html).

Uploading the CrossLang XTM Package
To upload the CrossLang-XTM package, proceed as follows:

1. Log into your AEM instance and navigate to Tools » Deployment » Packages:

£ - GRX. Package Manager col v

@ fem

,J
©
¢
B
§
§
i
g
§
§
i

Soctby i clienthib P

a— -

ece e com.adob lui.rte-€q5-5.10.26.2ip

- W

T —
et 1028 e

...... k2

- cq-social-enablement-pkg-2.1.29:zip p——

T — o
S 252 e
- 3 p——
@ 02.1p i

Ay g

2. Click Upload Package, then Browse, and find the package that you download from Adobe
Package Share:
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455 GRX Paskage Manager reli @ o

—
i
[Mtpecaon ______}
i
Groups Uphosd Package €
EE ——
. = = -
,'ﬂ Force Upioad:
5 ezl E—_

3. Click OK to upload the package.

Note: when accessing Package Share from within AEM, the package can be downloaded directly from
the Package Share interface by clicking the Download link.

Installing the CrossLang-XTM Package
To install the CrossLang-XTM package, proceed as follows:

1. Click Install to install the package:

€% GRX Package Manager | ;| w s

@ | Reset @ | [Search packages O create Package | Upload Package Administrator@crx defaut -
,.
Sort by CrossLang-XTM-Translation-Connector-1.1.0.zi
> g ranslation—Connector-1.1.0.zip OO nstan | 52MB
s VErSON: 1.1.0 | Last bult 2016/12/08 | Crasskang NV
Name - o This connector allows you

Last modified rmation about
Installation date

Recently added

B3 Share | 7058KE
Show

Al packages

New packages

Installed Built

| com.adobe.granite.ui.coralui3-1.0.140-CQ620~ @0 smare | 11M8
e B0004.zip
Groups Version: 1.0.140-CQ520-B0004 | Last installed 2016/12/20 | admin
= prov Granite package wrapping Coralul.
my_packages
Adobe (1) _ _ _
) com.adobe.granite.ui.coralui-3.0.52-CQ620- @ smare | 1718
Adobe (53) ol B0006. zip
com (2} Prov package wrapping CoralUl.

com.adobe.cq (2)

crosslang (1)

day ©7) - com_adobe_granite.monitoring.dashboard-1.5 60~ B0 Share | 177.9k8
a M €Q620-B0002.zip
- Version: 1.5.60-CQ620-B0002 | Last installed 2016/12/20 | admin
reppalicy Cranite Monitoring - Dashboard
SR

- com.adobe.granite.backup.content-0.0.52-CQ620- @7 share | 347 k5

m B0002.zip
Version: 0.0.52-CQ620-B0002 | Last installed 2016/12/20 | admin

Contains the initial content of the backup module

com.adobe_granite.ui.content-0.8.362-CQ620- @0 Share | 15 M8
B0021.zip
Version: 0.8.362-C0620-B0021 | Last installed 2016/12/20 | admin

s the initial content of the Ul module

Conts

Actvity Log B
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2. Click Install again to start the installation:

@ | Reset @ |[search packages [£| @ create Package | Upload Package Administrator@crx defaul -
Sort by o N -
i . o rossLang-XTM-Translation-Connector-1.1.0.zip D@ instan | 82MB
s Version: 11,01 Last built 2016/12/05 | Crosstang NV
Name CrossLang XTM for Adobe Experience Manager 6.2. This connector allows you
T miifed 10 translate AEM 6.2. content with XTM. For more information about
P — CrossLang XTM visit http:/ fwwav.crossiang com
Reteniye e Edt Buid Install Download Share More ~
Show Package: CrossLang-XTM-Translation-Connector
Al paciages Tnstall Package o)
. Do you really want to stal this package?
nstalled/Euit
-XTM-Translatic
Save Threshold: 1024
ENCEAcEUSy Number of transint nodes until automatic saving s triggered. Increasa if
Adobe (1) you encounter concurrent modification exceptions.
Adobe (53)
a1y Extract Subpackages: [
) Mark this checkbox to enable autormatic extraction of sub packages.
com.adobe.cq (2)
crosslang (1) Handing:
day (@7 Speciy how access control information is handled during import.
]
mabilcapp
rep:policy
sling
ﬂ EroonTUT Y TSN ZUT 72O
‘Contains the initial content of the legacy Ul module.
= «com.adobe_granite.ui.coralui3-1.0.140-CQ620— @0 Share | 1.1 MB
r B0004_zip
Version: 1.0.140-CQ620-B0004 | Last installed 2016/12/20 | admin
Provides the Granite package wrapping Coralll
= 1 com_adobe_granite.ui.coralui-3.0.52-CQ620- @0 share | 17M8
| itwiusll | R000A 7in 4
| Actvity Log

3. The package is now installed and ready for use:

Aecenty s35e3

Show.

New packages
instates fum

Groups

my_packages
Adbe 721

o 6

com adobe ca @)

com adobe ca inben (1)
crossng )

w50

"

metsesp

a0 poicy

oy

0131

CrossLang-XTM-Translation-Connector-1.3.1.zip
e Last inatated Apr 25 admin

£ Qerui o rane

ESt Buts Reist Ocemiss Suew Mo =
Fackage CrossLang-XTM-Transiascn-Comsector

Downioad  Crosstang-XTN-Trassiaten-Conmector-1 3.1 21 (8.3 M)
Croup crovng

Dependencies:  adete/granite com adone srante transianon contert 1 14
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4. Configuring the XTM Connect for AEM

This section describes the minimal configuration that is needed to make the integration work.

Creating a CrossLang XTM Cloud Service Configuration

After having uploaded the CrossLang-XTM-Translation-Connector package, a cloud service
configuration needs to be created.

To create a CrossLang XTM configuration, proceed as follows:

1. Navigate to Tools » Deployment » Cloud Services.

2. Inthe Third Party Services section, scroll to the CrossLang-XTM service and click Configure
now if this is the first configuration you are creating for the service or Show Configurations and
then [+] if you want to add an additional configuration to existing configurations.

3. Specify the following information:

Create Configuration %
Parent Configuration®™ | /etc/cloudservices/xtm-translation el
Title*® TMS-SUP Config|
Mame

CrossLang XTM configuration
) Account settings for XTM transiation access

International

Create Cancel

Title: This is the name of the configuration as it will be shown in the AEM interface. Can be any
value.
Name: (Optional) This is the internal name that AEM uses. The name cannot contain spaces.
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4. Click Create.
5. Specify the basic CrossLang-XTM configuration parameters:

CrossLang XTM Configuration *

Config

feb Service URIT* | |

Company™® | |

User Id* | |

Password® | |

Werify XTM connection

Customer

Project Template

Cancel

Web Service URI: This is the location at which the XTM web service can be reached. E.g.
"http://wstest2.xtm-intl.com/project-manager-
gui/services/v2/XTMProjectManagerMTOMWebService".

Company: This is the Company as specified in XTM. E.g. "Test Company".

User Id: This is the unique user Id of the XTM user that will be used for the interaction with XTM.
E.g. "1234".

Password: This is the password of the XTM user that will be used for the interaction with XTM.
E.g. "p4SSwOrd".

6. Click Verify XTM connection.

1. If the connection can successfully be established, the Customer drop-down will be
populated with the Customers in XTM that the specified user has access to.

2. If the connection cannot be established, review and correct the specified values and try
again until the connection passes.

7. Select the XTM Customer under which projects created by AEM will be created in XTM. Once a
Customer has been selected, the Project Template drop-down will be populated with the
templates in XTM for the selected Customer.

8. Select the XTM Project Template to be used for the projects created by AEM in XTM.

Note: Multiple CrossLang-XTM configurations can be created to provide for different needs. A typical
use case, for instance, would be different web site sections with different translation process
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requirements. Some content may not require review whereas other content might. In that case, the
user may want to create two CrossLang-XTM configurations: one with a Project Template selected
that includes a Review and Correct step, and another that does not include those steps.

Creating a Translation Integration Cloud Service Configuration

After having created a CrossLang-XTM cloud service configuration, a Translation Integration cloud
service configuration needs to be created.

To create a Translation Integration configuration, proceed as follows:

1. Navigate to Tools » Deployment » Cloud Services.

2. Inthe Adobe Marketing Cloud section, scroll to the Translation Integration service and
click Configure now if this is the first configuration you are creating for the service or Show
Configurations and then [+] if you want to add an additional configuration to existing
configurations.

3. Specify the following information:

Create Configuration ®
]
Parent Configuration® | /etc/doudservices/translation mFr
Title®
Name

Translation Integration configuration
a — Settings for Language Transiation

Create Cancel

Parent Configuration: Keep suggested value.
Title: This is the name of the configuration as it will be shown in the AEM interface. Can be any

value.
Name: (Optional) This is the internal name that AEM uses. The name cannot contain spaces

4. Click Create.
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5. Specify the Translation Integration Configuration parameters:

| Translation Config b

Sites Communities Assets

Translation Workflow Human Transhation b4
Translation Provider ¥TM Translation Service =
Options:

Translate Component L]

Strings
Translate Tags
Translate page assets Using Sites transfation workflow e

Auto-execute Translation D

Ok Cancel

Translation Workflow: select Human Translation.

Translation Provider: select XTM Translation Service.

Translate Component Strings: controls whether or not i18n dictionaries used in the components
of the page will be part of the translation job.

Translate Tags: controls whether or not associated tags will be part of the translation job.
Translate page assets: controls which translation workflow will be used for translating page
assets.

Auto-execute Translation: controls whether or not newly created translation jobs are started
automatically.
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Translation Config »

Sites Communities Assets

Translation Workflow Human Translztion 5
Translatien Provider ¥TM Translation Service w7
Options:

Translate Assets Lo

Translate Metadata L

Translate Tags Ci

ll'anilate Content Fragment | Inline Media Assets and Associsted Collections 7

ssets

Auto-execute Translation

0K Cancel

Translation Workflow: select Human Translation.

Translation Provider: select XTM Translation Service.

Translate Assets: controls whether or not referenced binary assets will be part of the translation
job.

Translate Metadata: controls whether or not associated metadata will be part of the translation
job.

Translate Tags: controls whether or not associated tags will be part of the translation job.
Auto-execute Translation: controls whether or not newly created translation jobs are started
automatically.

6. Click OK.

Configuring the Translation Integration Framework

For more information on the configuration options, please refer to https://helpx.adobe.com/experience-
manager/6-3/sites/administering/using/tc-tic.html.
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Applying the Cloud Service Configuration

Once the required cloud service configurations have been created, they need to be applied at the
desired level of your Site hierarchy.

To apply a cloud service configuration, proceed as follows:

Navigate to Sites, then to node in the site hierarchy at which level you want to apply the configuration.

Open the References tab (icon on top of the site list) and select the node to which you want to apply the
configuration. For example, the top level of the site:

+ s ° a W S & e &
) Rotmcces s "
o K 'y
..... . /I—
o e %
, . -
K =

Click View Properties, then CLOUD SERVICES:

Cloud Service Configurations

Select ‘Translation Integration’ from the drop-down and choose the Translation Integration cloud service
you created earlier from the Configuration Reference drop-down:
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Cloud Service Configurations

5. Select the desired CrossLang-XTM configuration from the CrossLang XTM and Translation Integration
drop-down:

Cloud Service Configurations

6. Click Save to confirm the configuration changes made.
7. Click Close to close the Properties screen.

AEM is now ready to submit content to XTM.
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5. Using the XTM Connect - AEM

This section describes the basic steps for translating AEM content with XTM.
Summary of steps:

Create a translation project and a translation job
(Optional) Scope the translation job

Start the translation job

Complete the translation job

Creating a Translation Project
To create a translation project, proceed as follows:

1. Navigate to Sites, then to the node in the source language's site hierarchy that you wish to create
a translation project for:

Products m

m;?gﬁn v n‘ nv n o+

2. Open References and expand the Language Copies section:

+ L] a8 LY + & & ]
O Reters Products ]
ansn e
= an - - :
GGE CoPES

Grde ] — Pr— =3

o = o f 5

=
o e

= e

25 Gesmetrio Oukdoors =

- =

e oo =

-
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3. Click Create & Translate and select the language copies you wish to add (Check Select all sub-
pages if you wish to include all child pages of the selected node in the translation project). From
the Project drop-down, select whether you want to create a new project or create a new
translation job for the selected nodes in an existing project:

o a L) L J & & ]
n

onms P -
e

P 9
e B
e P o P
-
e
e

Wy
-

RTREH

4. Specify a name for the translation project in the Title field and click Create to create the project:

o a L) + & & |
n
T = ~ :
w -
Fiomy Foes s o e =
-
r = L]
e —— =
Py G sams T =, ===
e
Fw o s a
o -
e
e
B o r A =
> e

Notes:

o If you selected the Create a new translation project option, AEM will create a translation project
with the cloud configuration applied to the selected node and will create a translation job that
holds the selected pages (and referenced assets if so configured).

e If you selected the Add to existing translation project option, AEM will create a translation job that
holds the selected pages (and referenced assets if so configured) within the selected project.

Scoping a Translation Job

Upon creating a translation project, AEM will automatically create a translation job under it that holds
the site pages that were selected for translation.
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To scope the translation job, proceed as follows:

1. Navigate to Projects > [project_folder] > [name_of_project_just_created]:

® o e

¢ 0w

2. Select Request Scope from the drop-down in the Translation Job tile:

o e

©

¢ a0 w

3. Click on the three dots in the Translation Job tile to see the Translation Job's contents and check
on scoping request progress:

Once scoping is complete, the Translation Job status changes to Scope Completed.

4. Select Show Scope from the drop-down in the Translation Job tile to see scoping information:
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Products Circle [FR] ~ add

Translation Project Sum. v Translation Job v Team (1) v Tasks (0) v

Adminit
e Qs | Lo a
el o L =
" (=120
fronch S Add Task

peovider Y
XTM Transiation Service * Export
[ =
ethos -] e ome
Aumen Tanettn
& isn Dictiong # Rename

DeletaTie

Scoping information is shown:

@ scope

sl Wrd Count.
CE Motz

100% Match
Repeiibon

If you click Details, a one-time link, that directs you to XTM, is generated:

A Redirecting

Yot b2 redirectod t 30 externsl page:

1y st the site choose Allow. f you do ot rus e st chooss Cansel

When you click Allow, the metrics for the XTM project are opened in another tab. Note that this is
a one-time link that works only once. To save the metrics displayed for future reference, choose a
value from the Save all as drop-down at the top right of the Metrics page.
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Characters

Characters . spaces

100%

To start a translation job, proceed as follows:

1. Navigate to Projects > [project_folder] > [name_of project_just_created]:

3) Adobe Experience Manager

Products Circle [FR] ~ m

Translation Project Summary v Translation Job v Team (1) v Tasks (0) v
Administrator
@ stztus Scope Complated
Language N
e o Add Task
Provider ©Q; Assets s

XTM Translation Service

B content Fragments

Method

Humzn Translation
&, ni8n Dictionaries

@ Tz

2. Select Start from the drop-down

in the Translation Job tile:
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3) Adobe Experience Manager

Products Circle [FR] v —
Translation Project Summary v Translation Job v Team (1) o = .
Administrator 2
@ status #% Show Scope
; Os.c
anguage -
French |
| P Add Task
©Q aAssets
Provider D hssets
o B

Method B con ments | (9 pye pate
Human Trenslation R
& 1t6n Dictionaries | # Rename
Delete Tile
¥ T

The translation workflow is now initiated on the side of XTM.

3. Click on the three dots in the Translation Job tile to see the Translation Job's contents and check
on translation progress:

}) Adobe Experience Manager

[-m} Translation Job ~
Title Path status Stote Asset Type
Circl New Page
Overview Jcontent/geometricdfriproducts/circlefoverview New Page
Festures Jcontent/geometriodit/products circle festures New Trsnsistion in progress Page
Assets Metadeta New Transiation in progress Assets Metadata
Tags Metadata New Ready for review Tags Metadsta

Completing a Translation Job

A translation job that has been started will move through the workflow steps of the workflow that was

configured as part of the XTM Project Template that was selected for the XTM-CrossLang cloud
configuration.

AEM will check the status of submitted pages and assets at the configured interval.

When a page or asset is found to have all workflow steps completed, AEM will automatically retrieve it
and show it with status Ready for review in the translation job:

3) Adobe Experience Manager

0 Translation Job ~
Title Path Status state AssetType
Circle Jcontent/geometrbadi/products/circle New Ready for review Page
Overview Jcontent/geometriai/procucts/circle overview New Resdy for review Page
Features Jcontent/geometrioufiiproducts/circle/features New Ready for review Page
Assets Metadata New Ready for review Assets Metadata
Tags Metadata New Ready for review Tags Metadata

Translated pages and assets can now be reviewed in AEM.

Once all pages have been reviewed, the Translation Job can be completed as follows:
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Navigate to Projects > [project_folder] > [name_of project_just_created]:

Adobe Experience Manager

Products Circle [FR] ~ Add

Translation Project Summary v Translation Job v Team (1) v Tasks (0) v

Administrator

Q st dy for

Language = pages
French (mhes Add Task
Provider
XTM Translation Service
Method

Human Translation

Click on the three dots in the Translation Job tile to open the Translation job:

<) Adobe Experience Manager S )
-} Translation Job ~
Title Path Status. State Asset Type
Circle [content/geometrixod friproductscircle Mew Ready for review Poge
Overview Mew Ready for review Page
Features [content/geometrixod friproducts/circle/features Mew Ready for review Poge
Assets Metadata New Ready for review Assets Metadata
Tags Metadata New Ready for review Tags Metadata

Click on one of the pages in the list or select multiple/all pages from the list. At the top, two
buttons become visible (Accept Translation and Reject Translation):

Iﬁ Accept Translation I Reject Translstion 2selected X
-] Translation Job ~
(== Title Path Status State Asset Type
. Circle content/geometrioc/fr/products/circle New Ready for review Page
Overviev w Jcontent/geometrixo/ér products circlefoverview New Ready for review Page
Features Jcontent/geometrbodfr/products/circle/features New Ready for review Page
. Assets Metadata New Ready for review Assets Metadata
Togs Metadata New Ready for review Togs Metadata

Click Accept Translation, if you want to approve the translation. A pop-up window opens.
Click Accept.
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& Accept Translation

10 aceept

- Circle
o Assets Metacats

Include references

-} Translation Job v
Title Poth Stotus state Assect Type
B Ge Jeontent/geometried/frlproducts/circle New Approved Poge
B Ooverview Jcontent/geometroodfr/products/circle/ovenview New Ready for review Page
B Feotures Jcontent/geometrood/friproducts/cicle/features New Ready for review Poge
B rcctMetadote Mew Approved Assets Metadata
B TegMetdata New Ready for review Tags Metadats

6. Click Reject Translation, if you don't approve the translation of the page. A pop-up window opens.
You can optionally add a comment. Click Reject.

A Reject Translation

You are going to reject translations for the following 2 tems:

« Features
- Tegs Metadata

Include references

Add Comment

Note: Any comments provided when rejecting pages will be not visible in XTM.

7. The status of the page(s) will show Rejected and will shortly after change to Translation in
Progress. The final step in the translation workflow in XTM has been reactived to allow for making

corrections.
] Translation Job v
== Title Path Status State Asset Type
B e fcontent/geometriax/fr/products/eircle: Hew Approved Page
B Overview Jeontent/geometrio/fr/products/circlefoverview Hew Ready for review Page
Features Jcontent/geometrix/fr/products/circlelfeatures Hew Rejected Page
B Assets Metadan Hew Approved Assets Metadata

Tags Metadata New Rejected Togs Metadata
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-m] Translation Job
Tite Path Status State Asset Type
B G Jeontent/geometrbadfrlproducts/circle Hew Approved Page
B Overview Hew Ready for review Page
B Festures Jcontentigeometriodfriproducts/circle/features New Translation in progress Page
B e Metadors New Approved Assats Metadata
B ez Metadats Hew Committed for translation Tags Metadata

6. Context Preview

Note: Context preview requires AEM 6.3.1.2 or higher and XTM Connect version 1.3.1.
Visual Editor

Context preview will send additional information such as graphics and stylesheets across to XTM in
order to allow XTM to open up the page that is being translated in its Visual Editor. Opening a page in
the Visual Editor will show the page almost exactly like it looks in AEM.

In AEM:

CONTACT | SIGNIN

Geometrixx T

CREATING SHAPES FOR CENTURIES

L PRODUCTS ¥ SERVICES ¥ COMPANY ¥ EVENTS 7 SUPPORT ¥ COMMUNITY BLOG

English » Products » Square »

FOUR SIDES, LIMITLESS POSSIBILITIES

LESS IS MORE MAKE A PLAN MORE 15 MORE

GET THE GEOMETRIXX APP
perfectly constructed, our square QOur squares can help you plan Break off the plane and soar, All things Geometrixx, anytime,
won't budge if you don't want it and organize environments from above, around, beneath, beyond. anywhere. Our mobile app is is as
to. From Donald Judd to Mies Van the bird's eye perspective. If you The cube represents the next groundbreaking and remarkably
der Rohe, this shape is the can imagine it, our squares can dimension for square enthusiasts. easy-to-use as our shapes.
starting point of wonder. manifest it.

PRODUCTS

Triangle

Square

Circle

Mandelbrot Set

© 2018 GEOMETRIXX INC. GEOMETRIXX NEWSLETTER

Feedback Newsletter We would like to keep in touch with you. Sign up here
0 receive our monthly newsletter on the latest
ProduUCTs and Services from Geometrboc.

Search Sitemap

Blog
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In XTM's Visual Editor:

The XTM user can view and edit the page being translated in the Visual Editor. Any changes made in
the Visual Editor will be reflected in XTM's Translation Memory and in the translated copy of the page
that will be retrieved by AEM once the translation workflow has been completed.

Configuration
To enable context preview, a page exporter configuration needs to be created for your site in AEM.
Creating a Page Exporter Configuration

For information on how to create a page exporter configuration, please refer
to https://helpx.adobe.com/experience-manager/6-3/sites/administering/using/page-exporter.html.

Once a page exporter configuration for your site exists, the XTM connect will, for each page to be
translated, create a zip file that contains an offline copy of the page with layout and automatically send
that zip file to XTM along with the XML source file that will be used for translation. XTM will combine
the information from the XML file and the zip file to show the page in the Visual Editor.

The Visual Editor is enabled in XTM by default for file formats for which it is supported. No
configuration is required.
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7. Additional Translation Integration Framework Configuration
Options

AEM's Translation Integration Framework has 2 OSGi configurations in AEM 6.3. These configurations
will influence the behavior of the AEM Translation Integration Framework and can be found
under http://localhost:port/system/console/configMar.

Translation Integration Default Config

Translation Integration default connector — The connector name of the system default implementation.
(defaultConnectorName)

Translation Integration default category — The system configured default category for the Translation
Integration framework. This value should correspond to a node name found within
/libs/granite/translation/resources/categories (defaultCategory)

Translation Platform Configuration

Scheduler Cron — Please specify cron format for changing the scheduling
(syncTranslationState.schedulingFormat)

Sync lock timeout — Please specify value in minutes after which translation sync lock will timeout.
(syncTranslationState.lockTimeoutInMinutes)

Export Format — Please specify the format for exporting translation jobs (export.format)
XLIFF Support

The AEM Translation Integration Framework can deliver the translation objects in either XML or XLIFF
format. Default is XML. XLIFF support can be enabled by changing the value of the Export Format
option of the Translation Platform Configuration OSGi configuration. To enable the use of XLIFF
(variant 1.2 or 2.0), the user must also install package okapi-xliff-service-pkg from Package Share.

AEM-XTM Language Mappings

The XTM connect for AEM defines its own language mapping list. This is to ensure that all the AEM
language codes map to a valid XTM language code. If a customer has changed the language codes
used in AEM, then he must make sure to update the mappings. Failing to do so will result in a
‘Language not supported' error. The connector's language mapping file can be found here:
/apps/crosslang/translation/config/xtm/languageMapping.
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